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Inception Digital Services, LLC (“IDS”) is a leading digital distribution service provider to film studios,
television networks, video distributors and independent content owners offering a wide range of digital encoding,
electronic packaging, and secure high-speed content delivery.

IDS possesses certified delivery access to all major online, broadcast media, and VOD platforms including
iTunes, Amazon, Netflix, Verizon, Sony Playstation, Microsoft Xbox, CinemaNow, InDemand,

Comcast, Echostar, Blockbuster, Hulu and Vudu.

Within this manual are the asset requirements and specifications for IDS

to properly encode, transcode, QC, package and upload each videos.
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ASSET REQUIREMENTS
The following details the assets needed for processing and delivery.
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Digibeta
Beta SP
HDD

S SOURGE FILE SPEGIFIGATIONS

VIDEO
Bit Rate > 50 Mbps
CODEC Apple ProRes 422 (HQ) OR 4:2:2 Color Space
NTSC: 720x480 for display at either 853x480 (16x9 content) or 640x480 (4x3 content)
RESOLUTION
PAL: 720x576 for display at either 1024x576 (16x9 content) or 768x576 (4x3 content)
SCAN TYPE All files must be progressive
STEREO AUDIO
PCM Audio, Little or Big Integer
Stereo Pair (as mapped below)
) TRACK 1
Stereo Pair on 1 track o Toft
PREFERRED ereo Le
( ) Sl Stereo Right
MULTI CHANNEL AUDIO
(5.1 Surround plus Stereo)
PCM Audio, Little or Big Integer
8 Separate Audio Tracks, mapped as below
TRACK 1 2 3 4 5 6 7 8
CHANNEL Left Right Center LFE Left Sur- RIGht SUr- | ¢t oreo Left | Stereo Right
round round

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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HD Cam

HD Cam SR
D5
HDD
HD SOURGE FILE SPEGIFIGATIONS
VIDEO
Bit Rate > 200 Mbps
CODEC Apple ProRes 422 (HQ) OR 4:2:2 Color Space
RESOLUTION 1920x1080 square pixel aspect ratio
SCAN TYPE All files must be progressive
STEREO AUDIO

PCM Audio, Little or Big Integer
Stereo Pair (as mapped below)

TRACK 1

Stereo Pair on 1 track

PREFERRED Stereo Left
( ) AL Stereo Right

MULTI CHANNEL AUDIO
(5.1 Surround plus Stereo)

PCM Audio, Little or Big Integer
8 Separate Audio Tracks, mapped as below

TRACK 1 2 3 4 5 6 7 8
CHANNEL Left Right Center LFE Left Sur- RIght Sur- | i oreo Left | Stereo Right
round round

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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TRACK CHANNEL DESCRIPTION
1 Left Music and Effects
2 Right Music and Effects
3 Center Dialogue
4 LFE Low Frequency Effects
5 Left Surround Music and Atmosphere Effects
6 Right Surround Music and Atmosphere Effects
7 Left Total Left Stereo Total
8 Right Total Right Stereo Total
>

Ok

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
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\ disital services ) TRAILER CONTENT SPECIFICATIONS

The following is content that is NOT suitable for all audiences and, thus,
considered “Unacceptable Content” within a trailer.

Content that fits the following criteria must be removed completely for the trailer to be acceptable.
Unacceptable content may NOT be fixed with censoring, including but not limited to:
audio “bleeping”, visual black bars and/or visual blurring.

O

0O O

O O o o o

Scenes with sexual activity
- ménage a trios -group sex - sadism
- masochism - bondage - necrophilia
- full nudity (partial nudity is allowed)

Sexual slang, references to venereal diseases, sexual references involving minors
Overt references to or scenes depicting rape and sexual molestation

Children in extreme peril, including verbal or physical abuse
- Children being anyone who is or depicts a person under the age of 18
- Scenes of violence or guns/weapons involving minors

Scenes of excessive violence

Scenes containing extreme or severe:
- Dismemberments - Mutations or Mutilations of bodies

People or animals on fire (except when the portrayal is clearly unrealistic to audience, i.e. a comic book character)

Use of tobacco, alcohol, or drugs by children

Any use or reference to
- scenes glamorizing drug use

Offensive/Obscene gestures

Offensive language, lyrics, text or graphics (in any language). Cannot be seen, heard, or read on screen.

- Fuck - Shit - Goddamn - Jesus Christ - Penis / Dick

- Vagina / Pussy / Cunt - Motherfucker - Tits - Bullshit - Dyke

- Faggot / Fag - Racial slurs - Derogatory - Etc.
comments

Use of the following words are allowed no more then once in a trailer
- Bitch - Damn - Crap
- Hell - Boobs - Ass

Extremely intense or frightening images

Sacrilege, including sacrilegious epithets referring to specific religious figures such as “Jesus Christ” or “Goddamn”
when used in a blasphemous way

Video Cards with unacceptable content:
Unacceptable video cards include:

- Video Information Cards - Green Band

- Color Bars - Web URL

- DVD Logos -HD Logo

- “Coming Soon” - “In Theatres Now”
- QR Codes - Dolby

- Hash Tags - Etc.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
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For all deliveries, an excel spreadsheet (provided) that contains
the following information must be filled out in completion.

Provider This value should be the Apple-defined label given for partner identification.

Video Subtype This value indicates how Apple should represent this video in the iTunes Store. FEATURE or CONCERT

Vendor ID The permanent value that uniquely identifies this film separately from any other film given by the pro-

vider. Only acceptable symbol is an underscore.

Country of Origin

The I1SO 3166-1 alpha 2 code of the country where the film was primarily produced.

Original Spoken
Locale

Specifies the language spoken by the actors in the film.

Title

The name of the film.

Synopsis

A general summary of the film’s content and story line.

Production Company

The customer-presentable name of the production company that created this film. Only one production
company can be specified.

Theatrical Release
Date

This is the date the film was first released in theaters.

Primary Genre

Films must specify at least one genre.

Rating System

An accepted rating system.

Rating

A valid rating from an accepted ratings system. More than one rating can be specified, but only one
rating per ratings system is allowed.

Rating Reason

The given reason for the films rating.

Caption Code

Must provide correct Closed Caption code.

Actor Name/
Character Name

Actors in the film, listed with the Characters they played.

Director

The Director(s) of the film.

Producer

The Producer(s) of the film.

Screenwriter

The Writer(s) of the film.

Sales Territory

The territory in which this video product is cleared for sale or VOD.

Cleared for Sale

Specifies whether or not this video can be sold for EST sale in the product’s territory. TRUE or FALSE.

Cleared for HD Sale

Specifies whether or not the video is cleared for HD EST sale in the product’s territory. TRUE or FALSE.

-SD

Wholesale Price Tier

The wholesale price tier for the film. FILM: 1-5, CONCERT: 201-204.

—-HD

Wholesale Price Tier

The wholesale price tier for the HD version of the film, if different than the SD.

Sales Start Date

The date this film is available for EST sale to customers in the specified iTunes Store territory only. AKA
the “street date” of the video.

Cleared for VOD

Specifies whether or not the video is cleared for rent,VOD sale, in the product’s territory. TRUE or FALSE.

VOD Type

Specifies whether the film is a NEW RELEASE or a LIBRARY title.

Available for VOD

The date this film is available for video on demand purchase in the specified iTunes Store territory only.

Physical Release Date

The release date of the first physical product (i.e. VHS, Beta, laserdisc, and DVD).

Cleared for HD VOD

Specifies whether or not this video is cleared for VOD in HD in the product’s territory. TRUE or FALSE.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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JPEG Image (.jpg)
2x3 Aspect Ratio
1400x2100 pixels MINIMUM
72 DPI
RGB Color Profile

UNACCEPTABLE CONTENT WITHIN KEY ART
URLs, DVD/BIuRay Logos, Release Date, or promotional tagging.
Art CANNOT contain Credit Blocks or Film Festival Laurels.

ART MODIFCATION PACKAGES

For all deliveries requiring IDS to modify art, a layered .PSD file of the key art is required.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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AUTOMATIC ASSET FAILURES

The following details the issues on an asset that will cause the file to be failed
while the file is in the Ingest stage. This happens BEFORE the digital file is created and/or QC’d.

SEGTION GONTENTS

Automatic Failures 11

Top Reasons for Asset Failure 12

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Any issue on this list will fail a file BEFORE the asset goes through the IDS QC Process.

Asset does NOT have 1 second of black at beginning and end
This occurs when video has less than 1 full second of black picture AND silence before and after the video.

Anything more or less that 1 second will not be accepted.

Asset is SD 4x3 Letter boxed
This occurs when video has black matting on the top and bottom of the picture. On an SD asset, this is
ONLY acceptable if the 4x3LB file is the only master available. If it is not, a new master will need to be requested.

Asset is SD Pillarboxed
This occurs when the video has black matting on the right and left sides of the video. On an SD asset,
this will not be accepted. A new master will be requested.

Asset is HD 16x9 Pillarboxed
This occurs when the video has black matting on the right and left sides of the video. On an HD asset, this is ONLY acceptable if the
4x3LB file is the only master available. If it is not, a new master will need to be requested.

Asset is HD 4x3 Letterboxed
This occurs when video has black matting on the top and bottom of the picture.
On an HD asset, this is will not be accepted. A new master will be requested.

Asset is windowboxed
This occurs when video has black matting on all four sides. This will not be accepted for any asset.
A new master will be requested.

Asset lacks any credits
All Feature Video Assets must have some sort of credits at either the beginning or end of the video, if not both.

An asset lacking any credits will not be accepted. A new master will be requested.

Asset is missing audio
This occurs when video asset recieved lacks the matching audio. This will not be accepted,

and a new master will be requested.

Incorrect resolution for delivery
This occurs when an Asset for HD delivery is received at less than 1080p resolution. (Ex. 720p to be sent as 1080p)

Files cannot be upresed, and will not be accepted. A new master will be requested.

Foreign language audio with no subtitles
This occurs when an Asset does not have the correct subtitles for the country of delivery. For example, all films for an American audi-

ence must have English Subtitles if the audio is not in English. The subtitles are preferred as a separate file.

Video hit on the Tape
This occurs when an Asset has a loss of data in a picture due to tape issues and/or mastering issues.

If the hit is on the received asset, the asset will not be accepted and a new master will be requested.

Audio Hit on the Tape
This occurs when an asset audio contains Digital glitches, pops, garbles, clipping that occur in the audio when they should not. If the

audio hit is on the received asset, the asset will not be accepted and a new master will be requested.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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1) Insufficient or Excessive Slugs at Head and/or Tail.
All content requires 1 second of black and silence at the head and tail of the file.

2) Uneven Cadence in Mixed Media.

This can cause dropped frames, duplicate frames, and interlacing artifacts. Experiment with both 23.98p and 29.97p processing to
determine which frame rate gives you the least amount of issues. If unsure of the proper process,

it is best to send an unprocessed file.

http://www.projectorpeople.com/resources/pulldown-3.asp

http://www.neuron2.net/LVG/interlacing.htm|

3) Video has been Standards Converted (typically PAL to NTSC).
This leads to ghosting throughout the content. Our platforms require files to be at the native frame rate of the original source.
http://en.wikipedia.org/wiki/Broadcast_television_systems

4)Video has been Improperly Processed.

29.97i content with cadence (pulldown applied) should be inverse telecined to 23.98p

while fully interlaced 29.97 video content should be made 29.97p. If unsure of proper process
it is best to send an unprocessed file in its original format.

5) Video/Audio Tape Hits.

6) Data Corruption.

Caused by loss of digital information during transfer or storage. This can either cause progressively worsening video hits

or cause the file to not open at all. One option could be to checksum files before and after transfer to ensure no data has been lost.
http://en.wikipedia.org/wiki/Data_corruption

1) Compression Artifacts/Pixelation/Macroblocking.
Often caused by up-converting low resolution content.
http://en.wikipedia.org/wiki/Compression_artifact
http://en.wikipedia.org/wiki/Pixelation
http://en.wikipedia.org/wiki/Macroblocking#Macroblocking

8) Aliasing.
Manifests as “stair-stepping” or “jaggies” on diagonal lines in the picture.
http://www.michaeldvd.com.au/Articles/VideoArtefacts/VideoArtefactsAliasing.html|

9) Insufficient Bit Rate.

HD content requires a bit rate of around 150-200 Mbps while SD requires 40-60 Mbps.
Many codecs do not support a high enough bit rate.
http://www.techterms.com/definition/bitrate

10) Not Best Possible Resolution/Aspect Ratio.

Content must be delivered at the widest aspect ratio available in the marketplace. This includes DVD’s, Blu-ray and digital.
For example, a 1.78:1 aspect ratio file cannot be delivered if there is a 2.35:1 master available.

4x3 letterboxed and 16x9 pillar boxed material is not acceptable unless there is NO other format available.

Trailers must never be a wider aspect ratio than the feature.
http://vimeo.com/videoschool/lesson/236/aspect-ratios-explained

11) Improper 5.1 + 2.0 Audio.

Audio mapped Left, Right, Center, LFE, Left Surround, Right Surround, Left Total, Right Total
with dialogue primarily on the Center channel.
http://hometheater.about.com/od/hometheateraudiobasics/qt/5-1vs7-1diff.-htm

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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QUALITY GONTROL EXANIPLES

Before a video is packaged and sent, IDS performs a Quality Check of the video.
Here are some examples of the more common issues
the QC team will find, and a brief description of each issue.

SEGTION GONTENTS

Interlacing 14
Interlacing Artifacts 15
Video Hits 16
Ghosting 17
Aliasing 18
Tearing 18
Macro-Blocking 19
Dot Crawl 19
Dead Pixels: Crop Top/Bottom/Sides 20
Pixelation 20
Moire 21

&

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
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Interlacing

Horizontal scan lines throughout picture. This occurs frequently around graphics.

Notice the horizontal lines that run throughout the entire image, particularly noticeable along the edges.

Notice the horizontal lines that run throughout the entire image.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Interlacing Artifacts

Horizontal scan lines that appear in some sections of the image.

Notice the scan lines that appear around the actor’s head and along his hand holding the phone to his ear.

Notice the scan lines that appear around and on the actor’s head and face.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Video Hits

Loss of data in a picture due to tape issues and/or mastering issues.

Notice the colored blocks scattered throughout the frame, that are obviously not part of the original image.

Notice the blocks scattered throughout the frame that look as though part of another image.
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Ghosting

A shadow on an image due to formatting conversions.

Notice the shadow of the same image around the actor’s hand and head.

Notice the overlay/shadow of the image on the dog’s tail, legs and mouth.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Aliasing

Jagged edges throughout or in some sections of the image.

Notice the block-stepping on all edges, most noticeable on the shoulder.

Tearing

A video artifcact where the continuity between scan lines is lost, resulting in visible
horizontal shifts inside the image. Banding is a severe form of even tearing across the entire image.

Copyright ©2006 Bad Rap, LLC.

Notice the offset of lines through the actors face (running across the image)

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Macro-Blocking

Loss of picture in several blocks of pixels. This is very rare to find in a file past ingestion.

Notice the even blocking throughout the image.

Dot Crawl

Consists of animated checkerboard patterns which appear along vertical color transitions.

Notice the checkerboard pattern on the edges of the colors on the flag.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Dead Pixels: Crop Top/Bottom/Sides

Dead pixel lines on the top, bottom or sides.

Notice what seems to be a black border on all four edges of the image.

Pixelation

The resolution of an image or a portion of an image is lowered introducing visible pixels.

Notice the sharp, square edges throughout, most noticeable on color transitions.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Moire

(More-AY) When two grid lines are overlaid at an angle, or when they have slightly different mesh size.

Most common on Black and White images, notice the rainbow effect throughout the image.

Notice the floor in the background, the grid-like lines create the rainbow effect across the entire area of the image.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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VIDEQ REPAIRS

This is a guide on the best ways to edit and repair files with issues
either inherent to the source, or created in the IDS workflow.

SEGTION GONTENTS

Interlacing Artifacts 23

Video Hit 24

Tearing/Banding 25

Dupe/Dup Frames 26

Drop Frames 27

Ghosting 27

Aliasing 28

Dot Crawl 29

Pixelation 30

Moire 31

Matting Logos/URLS Out Of Credits 32

Special Cropping Issues 32

Subtitle Burn-on i \
Interlaced Pal Content - 33 \

L4
O
g

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
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Horizontal scan lines that appear in some sections of the image.

1. TERANEXFIX

Request a Teranex repair from the account Rep.

Upon receipt of the Teranex repair work order, Teranex the asset in one of the following two (2) ways:

e Use Clean Cadence setting. (This will be the fix used for most content coming through the workflow)
e  Convert to Progressive (29.97p for video source, 23.98psf for film source).

e These fixes yield a 90% success rate.

If unsure of what setting to use test a five (5) minute clip with known issues to determine best result.
See Teranex section for more information.

2. MOTION FIX

Use only on trailers, music videos or very quick segments of the feature (credits, transitions, etc.).

After opening motion, be sure to use “Import as Project...” from “File” pulldown to ensure the project settings match the
asset.

Use “Deinterlace” filter. Choose from the following three method options at either “Upper” or “Lower” field dominance:
e Duplicate

e Interpolate

e Blend

Choose which method looks best, and “Export...” the video from the “File” pulldown menu.

A fix in Motion yields a 50% success rate.

3. FCP PATCH FIX

Use only on a single frame of interlacing.
Patch in FCP using the previous or following frame.

Notice the scan lines that appear around the actor’s head and along his hand holding the phone to his ear.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
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Loss of data in a picture due to tape issues and/or mastering issues.

1. Confirm whether or not hit is inherent to source material. (check multiple decks/stations, check channel conditions)

2. If hitis NOT inherent to the tape:
e Re-Ingest the section of the video.
e Patch re-ingested section into file.

3. If hitis on ONE frame, and IS inherent to the tape:
e Patch in FCP using the previous or following frame.

4. If hitis a corruption (the hit gets worse as you scroll over it)
e Re-Ingest the entire video.

Notice the colored blocks scattered throughout the frame, that are obviously not part of the original image.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
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Tearing is a video artifcact where the continuity between scan lines is lost, resulting in visible
horizontal shifts inside the image. Banding is a severe form of even tearing across the entire image.

1. Typically tearing is inherent to the source material, however, this must be confirmed, nonetheless. (check multiple
decks/stations, check channel conditions)

2. If tearing is caused by bad cadence in the source material, request a teranex repair.
e Upon receipt of the Teranex repair work order:
e Use Clean Cadence setting.
e Continue to process within normal workflow.
e Thisyields a 20% success rate.

3. Iftearingis on ONE frame, and IS inherent to the asset:
e Patch in FCP using the previous or following frame.

Copyright ©2006 Bad Rap, LLC.

Notice the offset of lines through the actors face (running across the image)

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.
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Frames that are duplicated/repeated.

1. If dupe frames are consistent throughout:
e double check if capture has cadence and was made 29.97 progressive by mistake.
e attempt to inverse telecine the capture file.

2. If dupe frames are just on small clips of slow motion effects:
e these are inherent in the content and cannot be fixed.

3. If dupe frames are caused by uneven cadence in source material, request a teranex repair.
e Upon receipt of the Teranex repair work order:
e Use Clean Cadence setting.
e Continue to process within normal workflow.
e This yields a 20% success rate.

4. If dupe frames are in short segments and evenly spaced throughout the segment:
e Cut out problem segment from file and open JES Deinterlacer.
e Onthe front page: Enter frame number to skip. (“Skip every __ frame” selection)
e Use “Bare project” selection.
e Export video, being sure the export settings are the same as source.
e see JES Deinterlacer for more information.
e Convert fixed segment file back to correct frame rate. ***process still under investigation***
e Edit segment back into full content in FCP. Export.
e This repair yields a 20% success rate.

DROP FRAMES

Frames that are missing from a sequence of frames, i.e. picture seems to jump ahead.

1. Check if drop frames are inherent in source material (tape, hard drive, etc).
2. If drop frames are inherent to source material, a new source must be requested.

3. If drop frames were added during processing:
e Try ingesting section through Teranex.
e Use Clean Cadence setting.
e Continue to process within normal workflow.
e This yields a 75% success rate.
e Test a different Compressor Template. This yields a 20% success rate.
e Try making progressive in JES Deinterlacer (will only work if there is a clean cadence present throughout).
e Use “Make Progressive” project for video source.
e Use “Inverse Telecine” project for film source.
e see JES Deinterlacer for more information.
e This yields a 20% success rate.
e Tryingesting through Adobe. ***process still under investigation***

4. |If drop frames are introduced into source material that has been standards converted (for example: PAL to NTSC):
e Request a master in the native format.
e Check the film’s country of origin on IMDB and determine if master’s format is correct. Ingesting from
a natively formatted master has the best chance of fixing the issues. Yields a 90% success rate.
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A shadow on an image due to formatting conversions.

1. Check if ghosting is inherent in source material (tape, hard drive, etc).
2. If ghosting is inherent to source material, a new source must be requested.

3. If ghosting was added during processing:
e Try ingesting section through Teranex.
e Use Clean Cadence setting.
e Continue to process within normal workflow.
e This yields a 75% success rate.
¢ Test a different Compressor Template. This yields a 20% success rate.
e Try making progressive in JES Deinterlacer (will only work if there is a clean cadence present throughout).
e Use “Make Progressive” project for video source.
e Use “Inverse Telecine” project for film source.
e see JES Deinterlacer for more information.
e This yields a 20% success rate.
e Try ingesting through Adobe. ***process still under investigation***

4. |If ghosting is introduced into source material that has been standards converted (for example: PAL to NTSC):
e Request a master in the native format.
e Check the film’s country of origin on IMDB and determine if master’s format is correct. Ingesting from a natively
formatted master has the best chance of fixing the issues. Yields a 90% success rate.

Notice the shadow of the same image around the actor’s hand and head.
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Jagged edges throughout or in some sections of the image.

1. Confirm whether or not aliasing is inherent to source material. (check multiple decks/stations, check channel conditions.

2. If aliasing is NOT inherent to the tape:
e Re-Ingest the section of the video.
e  Patch re-ingested section into file.

3. If aliasing is inherent to source material:
e Ingest through Teranex.
e Under the “enhance” tab in Teranex, turn “anti-aliasing” on.
e Set detail enhance set to -3 or -4. This softens edges, particularly on text.
***process still under investigation***

OR

e QOutput from Compressor with “noise removal” checkbox selected in filters tab. Settings known to have worked include:
e apply to: all channels
e terations: 1
e algorithm: replace

***process still under investigation***

4. Motion can sometimes repair aliasing if it is very clean and even using deinterlace video filter.

e Use only on trailers, music videos or very quick segments of the feature (credits, transitions, etc.).

e After opening motion, be sure to use “Import as Project...” from “File” pulldown to ensure the project settings match the
asset.

e Use “Deinterlace” filter. Choose from the following three method options at either “Upper” or “Lower” field dominance:
e Duplicate
e Interpolate
e Blend

e  Choose which method looks best, and “Export...” the video from the “File” pulldown menu.

e Afixin Motion yields a 40% success rate.

5. |If aliasing is added by cropping in Compressor:
e  Give progressive file to Transcoding Technician to crop in Rhozet.
e  Yields a 90% success rate.

Notice the block-stepping on all edges, most noticeable on the shoulder.
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Consists of animated checkerboard patterns which appear along vertical color transitions.

1. Dot Crawl cannot be added by any process performed in house.

2. If dot crawl is inherent to source material:
e Ingest through Teranex.
e Under the “enhance” tab in Teranex, turn “anti-aliasing” on.
e Set detail enhance set to -3 or -4. This softens edges, particularly on text.
***process still under investigation***

OR

e Qutput from Compressor with “noise removal” checkbox selected in filters tab. Settings known to have worked
include:
e apply to: all channels
e iterations: 1
e algorithm: replace
***process still under investigation***

A special note on Dot Crawl:

Dot crawl is a vestige of analog video broadcasting in which chrominance and luminance signals get scrambled
along vertical color transitions. Once introduced into digital video there is nothing we can do to completely
repair it.

Notice the checkerboard pattern on the edges of the colors on the flag.
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The resolution of an image or a portion of an image is lowered introducing visible pixels.

1. Confirm whether or not pixelation is inherent to source material. (check multiple decks/stations, check channel con-
ditions.

2. If pixelation is NOT inherent to the tape:
e Re-Ingest the section of the video.
e Patch re-ingested section into file.

3. Before attempting any other repair, request a higher resolution master from the rep, if available.

4. Asalastresort, If pixelation is inherent to source material:
e Ingest through Teranex.
e Under the “enhance” tab in Teranex, turn “anti-aliasing” on.
e Set detail enhance set to -3 or -4. This softens edges, particularly on text.
***process still under investigation™***

OR

e OQOutput from Compressor with “noise remova
include:
e apply to: all channels
e jterations: 1
e algorithm: replace
***process still under investigation***

III

checkbox selected in filters tab. Settings known to have worked

Notice the sharp, square edges throughout, most noticeable on color transitions.
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(More-AY) When two grid lines are overlaid at an angle, or when they have slightly different mesh size.

1. Confirm whether or not moire is inherent to source material. (check multiple decks/stations, check channel conditions.

2. If moire is NOT inherent to the tape:
e Re-Ingest the section of the video.
e  Patch re-ingested section into file.

3. If moire is inherent to source material:
e Ingest through Teranex.
e Under the “enhance” tab in Teranex, turn “anti-aliasing” on.
e Set detail enhance set to -3 or -4. This softens edges, particularly on text.
***process still under investigation***

OR

IM

e Qutput from Compressor with “noise remova
e apply to: all channels
e jterations: 1
e algorithm: replace

***process still under investigation***

checkbox selected in filters tab. Settings known to have worked include:

4. For moire that causes a rainbow effect on black and white images, one option is to apply Final Cut Pro’s “Desaturate” filter
(Located in Effects/Video Filters/Image Control). This should be used sparingly and only on the problem scene, not the entire
movie.

5. If moire is exacerbated by cropping in Compressor:
e  Give progressive file to Transcoding Technician to crop in Rhozet.
e Yields a 90% success rate.

Most common on Black and White images, notice the rainbow effect throughout the image.
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There are some instances where content contains a URL or Logo that is unacceptable
to send to the platforms and must be matted out.

Note: This should only be done on content with a black background.
Anything else requires a new source from the provider

1. Drop content into FCP timeline, being sure to match the sequence settings to your content when prompted.

2. Using the blade tool (b key), make an edit on either side of the content you need to matte.

3. Double click the clip in the timeline to open it in the Viewer window.

4. Under the Effects pulldown select Video Filters/Matte and then Eight-Point or Four-Point Garbage Matte as needed.
5. Click the Filters tab in the Viewer window to change the parameters of your matte.

6. Each point can be set by clicking the “+” radio button and then clicking where you want it to be on the Canvas
preview.

7. By default the matte appears around the points. | prefer to matte this way to make sure | only see the content
I am trying to get rid of and then I click “Invert”.

8. You can layer as many Garbage Mattes as you need on a clip for more complex matting.

Note: Adding Motion to mattes is possible for scrolling credits or other moving content but this process can be time
consuming and should only be attempted by someone who is very familiar with this type of work to avoid wasting time
trying to make it work.

SPEGIAL GROPPING ISSUES

There are some instances where content has a few scenes which require much greater cropping
than the rest of the content, and these spots make up more than 10% of the content’s runtime, the
provider may request we do an FCP edit to repair those scenes in order to comply with iTunes’
cropping specs. We rarely do this and a fixed master should be requested from the provider first.

1. Trim to scenes with cropping issues in Quicktime and Save As independent clips being sure to leave
some extra footage at head and tail.

2. Crop individual clips in Compressor being sure not to distort the aspect ratio by cropping unevenly.
3. Edit cropped clips back into content in FCP and export.

Note: If content is letterboxed the repaired clips may need to be matted to match the rest of the content
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There are some instances where content is a clean source, meaning no text is on the video.
In certain of these cases the account requests we burn on subtitles to the video
to create a new source with the subtitles on the video.

1. Drop content into FCP timeline, being sure to match the sequence settings to your content when prompted.

2. Add a new video track by right-clicking above your video track and selecting Add Track.

3. Drop your subtitle .mov onto the new video track. Across the top of the timeline a red line will appear indicating the
video is not rendered. Do not bother to render it as it might take hours and will only need to re-render if the
subtitles are shifted at all.

4. Locate the first subtitle and check if it lines up with the matching dialogue by scrubbing across the timeline using
forward and back arrow keys.
A good way to check if the lines are lining up correctly is to listen/look for proper nouns
(people’s names, place names) which are not typically translated.

5. Once the beginning is synced, check other spots throughout the content to ensure it is in sync throughout. If it s,
export for FCP per normal. This takes longer than normal export because the video require rendering.

6. If the subtitles drift out of sync you must return the title to the person who made the subtitle file for a fixed file.

Note: Be sure to keep both sources (CLEAN and SUBTITLED) when process is complete.

INTERLAGED PAL GONTENT

PAL should never be interlaced, but if it is digitized at the wrong field dominance,
it can appear to have interlacing.

1. Confirm whether or not interlacing is inherent to source material. (check multiple decks/stations, check channel
conditions.

2. |Ifinterlacing is NOT inherent to the tape:
e Re-Ingest the section of the video.
e Patch re-ingested section into file.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.




A &

Inception
\digita.l services )

THIRD PARTY MANUAL - 34

a Bonded Services Company

AUDIO REPAIRS

The basic workflow and steps to editing/repairing audio content at Inception Digital Services.

SEGTION GONTENTS

Audio Hit 35
Exporting 5.1 Audio from FCP 35
Audio Conform 36
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Digital glitches, pops, garbles, clipping that occur in the audio when they should not.

1. Confirm whether or not hit is inherent to source material. (check multiple decks/stations)

2. If hitis NOT inherent to the tape:
® Re-Ingest the section of the video.

e Patch re-ingested section into file.

3. IfhitISinherent to the tape:
e Patch the hit using another audio track, if available.
e ORrrip the DVD and use the DVD audio.

EXPORTING 5.1 AUDIO FROM FGP

When editing/repairing a file with 5.1 audio, it is important to export the audio
correctly to avoid errors in the file.

1. When you are ready to export 8 channel audio from your Final Cut timeline,
click on the Sequence pulldown and select Sequence Settings.

2. Select the audio outputs tab.
3. On the Outputs pulldown select 8.
4. Change each grouping to Dual Mono and change each Downmix pulldown to 0. Select OK.

5. Right-click at the head of each audio track, toggle Audio Outputs and select the proper track number.
| like to double check all my track output numbers before exporting.

ALL CONTENTS AND INFORMATION IN THIS MANUAL ARE PROPRIETARY TO INCEPTION DIGITAL SERVICES
AND MAY NOT BE USED OR REPRODUCED IN WHOLE OR IN PART WITHOUT THE EXPRESS, WRITTEN CONSENT OF INCEPTION DIGITAL SERVICES.




P '\ THIRD PARTY MANUAL - 36

Inception

a Bonded Services Company

\ digital services , AUDIO GONFORM

There are several reasons for the need of an audio conform.
Conforming audio means syncing the 5.1 to the Stereo to create a good 8 channel mix.

1. Place source video and stereo audio in FCP timeline. Be sure to change your sequence settings to match your video
settings when prompted. Move stereo to audio tracks 7 and 8.

2. Drop 5.1 audio into timeline and confirm it is in the proper channel order (left, right, center, Ife, left surround and
right surround). This should be done by looking at the waveforms and listening to each channel individually.

3. Trim any excess audio from the head of the 5.1, being sure to remove any tone and 2-pops.
4. Syncup 5.1 to stereo using a spot as close as possible to the beginning, preferably the very first audio you hear.

5. Scroll to the end and see if audio is in sync throughout. If it is, trim any excess audio from tail of 5.1. This is a good
time to double check black slugs at head and tail.

6. Set your audio outputs in System Settings and set tracks to output correctly. Export.

IF AUDIO IS NOT IN SYNC WHEN SIMPLY DROPPED INTO THE TIMELINE:

1. Sync up the beginning of the content then find an obvious sound near the end to use as reference (a car door slam-
ming, etc).

2. Place a marker on that sound on the Video/Stereo tracks in the timeline by clicking those tracks and hitting the “m”
key. Be sure your 5.1 audio tracks are linked by highlighting them all in the timeline and and selecting Link from the
Modify pulldown.

3. Find the same sound in the 5.1 audio and place a marker on it. If sound on 5.1 occurs before the stereo, the 5.1
needs to be slowed down. If the sound on 5.1 occurs after the stereo, it needs to be sped up.

4. Right-click on your 5.1 audio and click “Speed”. The speed change menu will appear. Make sure Constant Speed is
selected. There are two typical percentage changes that will work for most audio conforms:
e |f 5.1 marker is before stereo marker, adjust audio speed to 99.9%.
e |f 5.1 marker is after stereo marker, adjust audio speed to 100.1%.

IMPORTANT: Once audio speed is adjusted you can no longer rely on waveforms as they become inaccurate. Look at
the markers you placed and BE SURE TO LISTEN and reset markers as need be as they can sometimes shift around when
audio speed is changed!!

5. If one of these percentage changes does not do the trick, start slowly adjusting the duration of the 5.1 audio in the
Speed window. Adjusting the duration frame by frame is much more accurate than adjusting percentage. Contin-
ue to zero in on the proper duration until synch is achieved, then set your audio outputs in System Settings and set
tracks to output correctly. Export.

Remember to check for sync throughout the feature before exporting.
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ASSET GHEGKLISTS

Before being uploaded, all complete packages at IDS will undergo
a thorough inspection, confirming all assets and meta are correct.

The following contains example checklists used as guides for pacakge review.

SEGTION GONTENTS

General Checklist - iTunes 38
Audio Checklist 41
Video Checklist - Film 42
Film Package Checklist - iTunes 43
X
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Package Pre-Check

[] Check all assets are in the .itmsp folder in Packaging
e Chapter Images

e Art.jpg

e Captions/Subtitles or PDF

e Best source letter (if needed)

e Preview QCR

e  Preview .mov

e Source QCR

e Source.mov

e metadata .xml

Check All Assets

[] Chapter Images

e All Images are cropped and the same size

e DPI=72

e Color =RGB

e Content is acceptable to MPAA/IDS standards
e Last image is of the Credits (if possible)

[] Art.jpg
e Size =1400x2100
° DPI1 =72

e Color=RGB
e Content is acceptable to MPAA/IDS standards
e No Logos, URL's, MPAA ratings

[] Captions/Subtitles or Valid Reason Code

[] Captions
e .scc NDF
e Insync beginning, middle, and end

[] Subtitles
e .itt (see chart for acceptable frame rates)
e Insync beginning, middle, and end

[] Reason Code
e Valid Reason Code confirming no Closed Captions for title
e  Code states one of the accepted reasons :
e  “NEVER_IN_US": Video has never been exhibited on U.S. television.
e  “ARCHIVAL_CONTENT”: Video is archival content.
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[] Source Notes

PDF stating we have the best possible source for title

[] Preview QCR

[] Preview.mov

Apple ProRes 422 (HQ)

First second of black

Last second of black

Is there a Logo

In sync : beginning, middle and end

All audio Channels have audio, are in order and in sync
Cropping numbers are provided

Content is acceptable to MPAA/IDS standards

[] Source QCR

[] Source.mov

Apple ProRes 422 (HQ)

First second of black

Last second of black

Is there a Logo

In sync : beginning, middle and end

All audio Channels have audio, are in order and in sync
Cropping numbers are provided

Content is acceptable to MPAA/IDS standards

[] Metadata .xml

[ ] Match meta top to bottom
e Copyright Date is in front (no @)
e  Theatrical release Date “YYYY-MM-DD”
e Genres
e Ratings
e Cast Names and Charaters
e Directors, producers, screenwriters
e All Chapters are there

[] Check last chapter time with source .mov

THIRD PARTY MANUAL - 39
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[ ] Cropping numbers match QCR and source .mov

[ ] Captions Codes - If “false” then...
e  “NEVER_IN_US": Video has never been exhibited on U.S. television.
e “IN_US_NO_CAPTIONS": Video has been exhibited on U.S. television, but never with closed captions.
e “EDITED_FOR_INTERNET”: Video has been substantially edited for Internet distribution.
e  “ARCHIVAL_CONTENT”: Video is archival content.

[ ] Source notes, Captions/Subtitles, PDF’s and .mov files are there with Checksums and sizes

[l

Is the source Textless? Is there Forced Narrative? are there Subtitles?

[] Product Info
e Territory
e (Cleared for sale “true/false”
e (Cleared for HD sale “true/false”
e  Price tier “#”
e  Sale Start Date “YYYY-MM-DD”
e (Cleared for VOD “true/false”
e VOD type “Library/New Release”
e VOD Date “YYYY-MM-DD”
e  Physical release Date “YYYY-MM-DD”
e (Cleared for HD VOD “true/false”
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AUDIO CHEGKLIST

[ ] Audiois present and consistent throughout video
Audio at beginning (1 second of black before audio starts)

o

[
[
[
[

1 second of black after audio ends
Audio at throughout Credits/End of File

Audio exists on every Audio Track

5.1 labeled correctly/In the proper order
Track 1: Left

Track 2: Right

Track 3: Center

Track 4: LFC

Track 5: Left Surround

Track 6: Right Surround

Track 7: Left Total

Track 8: Right Total

Audio clean of the following:
hits

2 Pop

pops

drops

sync issues

drift issues

Stereo labeled properly
NO “MONO” EVER
No MATRIX Stereo

Audio Codec is Correct
Audio is LPCM
Audio fits one of the following:

24-bit Integer (Little Endian), 48.000 kHz
24-bit Integer (Big Endian), 48.000 kHz
16-bit Integer (Little Endian), 48.000 kHz

16-bit Integer (Big Endian), 48.000 kHz
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[] Correct Video Codec
Apple ProRes 422 (HQ)

[] Correct Video Bit Rate
e HD: 220 Mbps
e SD:40-60 Mbps

[] Correct Pixel Ratio
HD: Pixel ratio in parenthesis = AUTOMATIC FAIL (Has CLAP)
SD: NO Pixel ratio in parenthesis = AUTOMATIC FAIL

Acceptable Examples: SD 4x3: 720x480 (640x480) SD PAL 4x3: 720x576 (768x576)
HD: 1920x1080 SD 16x9: 720x480 (853x480) SD PAL 16x9: 720x576 (1024x576)

[] Correct Aspect Ratio:
e Letterbox (Cropping numbers provided in QCR)
e  Pillar Box (Cropping numbers provided in QCR)
See Frame Size Aspect Ratio Examples for more information

[ ] One (1) second of black at START of file.
One second of black before either or both the Video and Audio begin, whichever starts FIRST.
Can have NO MORE and NO LESS than 1 seconds of black. Anything else Fails QC & must be trimmed.

[] One (1) second of black at END of file.
One second of black after either or both the Video and Audio ends, whichever ends LAST.
Can have NO MORE and NO LESS than 1 seconds of black. Anything else Fails QC & must be trimmed.

[] Credits
All videos must have credits at the beginning and/or end of the video.

[ ] Video Cards with unacceptable content:
Unacceptable video cards include:

e Video Information Cards e Web URLSs (Trailers Only) e HDLlogo
e Color Bars e DVD Logo e FEtc.

[ ] Video clean of the following issues :

e Hits e  Field Order Issue e Dup Frames

e Interlacing e Dot Crawl e Dropped Frames
e Interlacing Artifacts e Moire e Freeze Frame

e Aliasing e  Corruption

e Tearing e  Pixelation

e Ghosting e Dead Pixels (Crop Top, Bottom, Sides)
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[] Checksum Assets

[] Source [] Preview [] KeyArt [] Chapter Images
[] Source QCR [] Preview QCR [] Caption File [] Subtitle File, etc.
[] Metadata

Provider, Vendor ID, Title, Synopsis, Cast, Crew, etc.

[] Product Info
VOD/EST Availability and Dates.

[ ] Chapter Titles
As listed in Metadata Excel Sheet. If “Chapter Create” then use “Chapter 1, Chapter 2, etc.”

[] Chapter Times
In HH:MM:SS format. Round to the nearest second.

[ ] Verify spoken locale
Play both source and preview files. Double check the spoken language matches what is in the metadata.
Verify locale names and codes with IDS Naming Spreadsheet.

[] Source Spoken Locale:

[] Preview Spoken Locale:

[ ] Verify aspect ratio
[] Source

[] Preview

[ ] Verify chapter times are correct
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REVISION HISTORY

A comprehensive history of all revisions made to the
IDS THIRD PARTY MANUAL
arranged by version number, and section,
starting with the latest changes first.

ok
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VERSION 4.1

e Added ‘MULTI CHANNEL AUDIO CONFIGURATION (5.1 PLUS STEREO)’ pgb
Breakdown and description of what should be on each channel.
e Updated ‘KEY ART SPECIFICATIONS’ pg9.

Cannot contain Credit Blocks or Film Festival Laurels.

VERSION 4.0
*  Updated ‘TRAILER CONTENT SPECIFICATIONS’ pg7

Acceptable content has changed regarding nudity, guns, and censorship.

VERSION 3.9
*  Updated ‘GENERAL CHECKLIST: iTUNES’ pg37

No longer accepting PDF Letters - Now accepting Valid Reason Codes.

VERSION 3.8
e Updated master pages; Content pages now plainer, with logo and copyright statement.
e Added “HDD” as ‘ACCEPTABLE TAPE SOURCE’ in “ASSET REQUIREMENTS”
e Added CC Line on “METADATA NEEDED FOR DELIVERY” pg7
e Updated “TOP REASONS FOR ASSET FAILURE”
- Point 2
e Revised “ASSET CHECKLIST” contents

VERSION 3.7
e Updated format to include new Company Logos and Designs.
e Updated “TRAILER CONTENT SPECIFICATIONS”
- Compiled detailed list to describe content “Acceptable for All Audiences”
e Updated “AUTOMATIC ASSET FAILURES”
e Added “ASSET CHECKLIST” section
e Added “VIDEO REPAIRS” and “AUDIO REPAIRS” sections
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